UBUNTU STUDIO
UBUNTU 7.10 WITH MULTIMEDIA

LISTEN UP!
NEWS ON THE FORTHCOMING
FULL CIRCLE PODCAST!

WUBI!
THE WINDOWS
UBUNTU INSTALLER
News
Flavor of the Month: Ubuntu Studio p.04
How-To:
Simply Install SSH p.06
Terminal On Your Desktop p.08
Convert From Windows p.10
Learning Scribus - Part 7 p.11
Review - Wubi Installer p.13
Poll - Favorite Email Client p.15
Interview:
Howard County Library p.18
My Story - Windows to Ubuntu p.21
Ubuntu Youth p.23
Sound Bites p.24
Letters p.25
Q&A p.27
My Desktop p.28
Top 5 - Audio/Video p.29
How to Contribute p.31

All text and images contained in this magazine are released under the Creative Commons Attribution-By-
ShareAlike 3.0 Unported license. This means you can adapt, copy, distribute and transmit the articles but only
under the following conditions: You must attribute the work to the original author in some way (at least a name,
email or url) and to this magazine by name (full circle) and the url www.fullcirclemagazine.org (but not attribute the article(s) in
any way that suggests that they endorse you or your use of the work). And If you alter, transform, or build upon this work, you
must distribute the resulting work under the same, similar or a compatible license.
Welcome to the November issue of Full Circle. We've got a few new things for you this month.

Next month we will be launching the Full Circle Podcast hosted by Matthew Rossi. Matt has answered the most common questions about the podcast on page 22. If you want to be kept informed of all things Full Circle (podcast included) then I would recommend you keep an eye on our Google Calendar (see page 16 for the link and URL). On there will be meeting dates, deadlines, podcast release info and more.

Speaking of the podcast, Matt has also written us some news and also the new Sound Bites column which will give you a taste of what may well be in the next podcast. The podcast is there to complement the magazine and will have different content. I don't decide what will be in the podcast, Matt does.

Next month is, of course, Christmas month and that reminds me, if you'll excuse me, I must go and buy some Christmas decorations for next month's issue...

All the best,
Ronnie
Editor, Full Circle Magazine
ronnie@fullcirclemagazine.org

What is Ubuntu?
Ubuntu is a complete operating system that is perfect for laptops, desktops and servers. Whether at home, school or at work Ubuntu contains all the applications you'll ever need including word processing, email application and web browser.

Ubuntu is and always will be free of charge. You do not pay any licensing fees. You can download, use and share Ubuntu with your friends, family, school or business for absolutely nothing.

Once installed, your system is ready-to-use with a full set of productivity, internet, drawing and graphics applications, and games.

http://url.fullcirclemagazine.org/7e8944
Ubuntu Scores First Major Pre-installed Server Win

Early next year, Dell is expected to announce that Ubuntu Server will be certified on Dell server lines.

Ubuntu is extremely popular on the desktop, but it's made comparatively little progress on servers. That's about to change. Dell is expected to announce in the first quarter of 2008 that it has certified Ubuntu Linux for its server lines.

In an interview with Rick Becker, Dell Product Group’s vice president of solutions, Becker said that Dell is currently in the process of certifying Ubuntu for all its server lines. “But we are still several months away from announcing a certification. I’d say it’ll be announced in Q1 next year.”

Source: eWeek
http://url.fullcirclemagazine.org/03e7df

Vista Worries Cause Businesses to Consider Macs and Linux

A recent survey shows that 44 percent of businesses are considering Mac OS and Linux rather than switching to Vista.

KACE, a systems management appliance company, announced on Nov. 19 that its new survey revealed that 90 percent of the Windows users are concerned about migrating to Vista, and that 44 percent would consider deploying Macs or Linux-based systems to avoid Vista migration.

While Microsoft claims that Vista deployments are increasing, analysts, such as Forrester, observe that business Vista adoption has been going extremely slowly and that Linux is becoming a serious contender for the enterprise desktop.

Source: eWeek
http://url.fullcirclemagazine.org/987a9d

Hans Reiser, the owner of Namesys, which offers file systems for Linux, is on trial for murder charges related to his wife's disappearance last year.

Reiser developed ReiserFS, the default file system on many Linux distributions. Free software advocates hold Reiser’s work on the program in high regard.

Reiser married a Russian woman who advertised in a mail-order bride catalogue. The woman, Nina Reiser, had two children with the developer, obtained citizenship, and filed for divorce.

Nina Reiser was last seen dropping off her children at Hans Reiser's mother's home, where the developer was living, in September 2006. Police found her car, full of groceries, in a grocery store parking lot not long before the couple was scheduled to appear in court for a child support dispute.

Police never found a body. Hans Reiser's attorney argued in court that Nina fled to Russia and is in hiding, possibly because her estate stands to benefit financially from a murder conviction. Nina's divorce lawyer said that Hans Reiser's company, Namesys, has no value.

Source: Information Week
http://url.fullcirclemagazine.org/74a52b
gOS is a new distribution based on Ubuntu 7.10 which is being shipped with new low-cost Walmart PCs, and a special motherboard for developers, both being USD199 and USD59 respectively. The software revolves around Google Apps - you could call it a Web 2.0 distro. They have released version 1.0 (Initial G) as an alpha for those who wish to test it. The 728MB ISO can be downloaded from a torrent which you can find at their website. "We're creating an OS ecosystem that is complete. We come with all the software you need to browse the web, email, instant message... play movies, music, and connect to iPods... create and edit documents, spreadsheets, presentations, databases, images... out of the box. Plug and play!" [http://www.thinkgos.com](http://www.thinkgos.com)

In the "Distrowatch Weekly Newsletter" Issue 227, Susan Linton does a review of the latest release of Ubuntu Studio 7.10 (see this issue's [Flavor of the Month](http://www.fullcirclemagazine.org) for a step-by-step install of Ubuntu Studio), a distro aimed at multimedia users. She says:

"Although I thoroughly enjoyed Ubuntu Studio in the past and this release of Ubuntu Studio seems sound for the most part, I couldn't help but feel my enthusiasm wane. It's still a fun and useful system, but it just didn't excite me as before. At first it felt like I was reviewing the same Ubuntu Studio that I did six months ago, with the only real improvement found in the installer."

You can read the full review at [http://url.fullcirclemagazine.org/cbc989](http://url.fullcirclemagazine.org/cbc989).

Mythbuntu 7.10 has been released. Mythbuntu is a variant of Ubuntu, which, as the name suggests, acts as a front-end for the popular MythTV media centre software. If not in MythTV, Mythbuntu runs the XFCE4 desktop with all of the regular programs that you'd expect out of Ubuntu.

"The Mythbuntu team is proud to present the first stable release of Mythbuntu. This release is based upon Ubuntu 7.10 (Gutsy Gibbon). We would like to thank everyone that has volunteered to help make Mythbuntu reach where it is today."

[http://www.mythbuntu.org](http://www.mythbuntu.org)

The [Ubuntu Screencasts Project](http://url.fullcirclemagazine.org/359efc) has released a screencast on how to install Xubuntu onto your computer. It goes over downloading the image, burning the image, installing Xubuntu, the included programs, customizing your desktop, and some basic terminal commands. If you are interested, then please check it out at [http://screencasts.ubuntu.com/Installin g_Xubuntu](http://screencasts.ubuntu.com/Installin g_Xubuntu)

Kelly Rush has written an excellent article, with his insight into Ubuntu and his application of it at home.

"I've used Ubuntu Linux now for the better part of a year; there have been some stumbles along the way, but for the most part, I'm sold. I find myself having to do a bit more maintenance than I would with Windows, but I also like the flexibility that it affords me, along with knowing that I'm not being forced into using software in ways I don't want to (DRM), and not having to pay multiple hundreds of dollars to use it."
In this month's flavour of the month we'll show you how to install Ubuntu Studio - a flavor of Ubuntu dedicated to multimedia creation. This flavor includes all the best open source multimedia software for all your needs, from simple image editing to video creation, so you can make the most of your Ubuntu PC.

Ubuntu Studio uses the alternate install method, so unfortunately you can't use it as a Live CD. If you don't have experience in using a textual user interface, there is a guide to the keys you'll need at the bottom of each step, so if you get stuck, just look down! Basically you use the arrow keys to select an option, then press enter to select it.

The first step once you've chosen 'Install in text mode' is to choose your preferred language, followed by your country in the next step. You will then get the default alternate install keyboard detector.

Select yes (the default option), then press the keys it says if you have them.

After keyboard detection, the first of the hardware detection screens appears. This detects your hardware so it can install the correct drivers for your system. There will be several of these throughout the install, so don't worry if I don't point them out.

In the next step you must choose a hostname for your system. This should be something to easily identify your PC on a network, e.g. 'family-desktop'. If you don't have a home network it doesn't matter, just enter a fun name of your choice.

The next step is to partition your hard drive.
This can be done in the usual way, and if you aren't sure, you can cancel the installation and ask someone. The option you choose here varies depending on your circumstances, so go for the one that looks right. As always, I must stress the importance of backing up important data before going past this step! When you get to the end of the partitioning section of the install it will display a summary of all your partitioning options, so you'll be able to check if anything looks wrong.

Continuing the installation, you'll be asked whether the system time is set to UTC. If you are unsure, just go for the default of yes, and if it turns out to be wrong you can change it later. Once you've decided, you can move onto user setup.

In the user setup you will need to enter your real name, a username and the user's password. This user will be the system administrator, and have full access to the system, so choose a secure password.

The installer will now install the base Ubuntu system with your settings. Once the base system is installed, you will be asked about additional packages to install.

Use the space bar to select multiple items, then continue. Make sure you install the 'Ubuntu Studio Desktop' option - if you don't do this then you will not get a graphical user interface when you restart after the install! The installer will now finalize the installation, then prompt you to restart.

Once you have restarted you will get the Ubuntu Studio login screen, where you can enter your username and password.

Now you can start creating!
SSH (Secure Shell) is a protocol that is used to remotely connect to another computer running an SSH server. The standard interface is a simple command line, although you can also run graphical (X11) applications on a Linux or BSD server. Below, we will cover setting up a client, server, and connecting the two.

### Setting up a server

1. Launch Synaptic (or Adept if you use Kubuntu) System > Administration > Synaptic Package Manager and enter your password.

2. Search for the "openssh-server" package and click on the empty checkbox. Choose "Mark for Installation" from the menu.

3. Repeat the above step for the package "inadyn". (This will come in handy later.)

4. When asked "Apply the following changes?", click Apply.

5. The package should install. Click "Close" and quit Synaptic.

Now you have a server installed!

You might be wondering what you can do with it. Well, you can do a lot of things - from remote file transfers to running applications on your computer from another one. Before you can do that, though, there are a few more steps. First, you have to know how to connect to your computer remotely. First let's set up a dynamic DNS account so you can access your computer via an easy to remember subdomain, not a lengthy IP address.

1. Go to [www.dyndns.com](http://www.dyndns.com) and click "Create Account" underneath the login box at the top of the page.

2. Choose a username, password, and all the rest of that nice stuff.
3. Confirm your account with the email they sent you and log in.

4. Click the "My Services" link and choose "Add New Hostname" on the new page that comes up.

5. Choose a hostname, subdomain, and click the auto-detected remote IP link underneath the "IP Address" field. Click "Create New Host".

6. Next, go to your terminal and type:

gksudo gedit /etc/crontab

press Enter and then type in your password.

7. Type in

```
0 * * * * inadyn -u your_username -p your_password -a name.you.registered > /dev/null
```

all on one line. I can't stress this enough - don't delete or change anything else.

8. Save and quit.

9. You should be able to access your computer via the domain you registered in about an hour.

To connect to your computer, simply type in:

```
ssh [username][registered.subdomain]
```

from a terminal. The first time you connect from a particular machine, you might get a message saying "The authenticity of host [subdomain] (IP address) can't be established." You can safely ignore this - type "yes." Next, you should be prompted for a password. If you enter that correctly, you should be at a command line prompt - on your computer!

Some neat tricks you can use with SSH:

**Run graphical applications**

Type:

```
ssh -X username@subdomain
```

at a terminal. Enter your password like normal. Now, type in the name of a graphical application at the command prompt (like "nautilus" or "thunar"). It should show up on the computer you're at, except it's running on your computer.

**Copy files**

Type:

```
scp username@subdomain:/path/to/file username_for_comp_you're_at@localhost:~/
```

and this will copy the file into your home folder.
This interesting customization will allow your desktop to become a fully functional terminal. The objective is to have a gnome terminal running right above the actual background image that won't be displayed by the statusbar or ticker.

Create a configuration file named DesktopConsole.ds (again, in a terminal):

```
nano ~/.devilspie/DesktopConsole.ds
```

Input the following into the file (press Ctrl+ X to save and exit):

```c
(if
  (matches (window_name) "DesktopConsole")
  (begin
    (set_workspaces 4)
    (below)
    (undecorate)
    (skip_pager)
    (skip_tasklist)
    (wantype "utility")
    (geometry "+50+50")
    (geometry "924x668")
  )
)
```

Notes:

- I use workspace 4 but you can use whatever you like.

- You should at least adjust the geometry lines to match your screen.

- Read the devilspie wiki, for other commands!

Create a new gnome-terminal profile named "DesktopConsole" by doing the following:

- in the "General" tab, untick "show menubar by default..."

- in the "Scrolling" tab, select "Scrollbar is" > Disabled.

- in the "Effects" tab, set "Transparent background" and shade to "None" (or to whatever you prefer)

Add devilspie and gnome-terminal to the Startup Programs in your session:

Download and install the devilspie package. In a terminal type:

```
sudo apt-get install devilspie
```

Make a folder for devilspie in your home folder by typing:

```
mkdir ~/.devilspie
```
in a terminal.
in System > Preferences > Sessions, "Startup Programs" tab, add the 2 programs:

devilspie

and:
gnome-terminal --window-with-profile=DesktopConsole

Log out, then log in.

Check to see that devilspie is running before the gnome-terminal command.

That's it!

**HOW-TO**

Written by Todd Millecam

I could give you a full and complete guide to doing so—but it would be a novelette, and not very practical for the new user. The best thing to have when converting is a good attitude and a willingness to learn. This is a bare-bones guide—for a more complete one, search the forums.

**CONVERT FROM WINDOWS**

The first thing you will need to know is how to get the software you want on your computer. Believe it or not, it's easier to do this in Ubuntu than it was in Windows. Simply click Add/Remove in the Applications menu, and then search for the kind of program you're looking for. Click the check box next to the program, click "OK", and you should be good to go.

If you can't find a program in add/remove, try adding a repository which has it (a repository is an online database of software — Add/Remove generates its list from the repositories)

Second — dealing with application hangs and freezing. In Windows there was Ctrl-Alt-Delete for all your freezing needs. In Ubuntu, you have a bit more available to you. You can restart your session by pressing Ctrl-Alt-Backspace — which is highly effective in every case I've encountered. If you don't feel like dropping everything just because one application froze, you may want to right click on one of your panels and add two programs there: System Monitor and Force Quit. Force Quit will kill whatever application window you click on, and System Monitor will give you a list of processes.

Of course, you have to be mindful of compatibility if an application keeps hanging. Software made for Edgy won't work very well in Gutsy. You can
check your system version in system monitor (far left tab), and you
can usually check the version of the software before you
download, or under the "Help" menu on the "About" option.

There are some things that are just plain different, that you'll
need to get used to. The most
notable of these are workspaces.
Linux gives you four desktops in
one — just to help keep things
organized. You can switch
between them by pressing Ctrl-Alt-
Right arrow (left arrow also
works), or by clicking on the gray
boxes in the bottom right.

If organization is your thing you
might also want to consider a
"home partition." This is an area
of space that you set aside on
your hard drive that both Windows
and Ubuntu can read (you can
format this partition in FAT32,
NTFS or ext2, but with NTFS, you
may need a configuration tool for
Linux, and with ext2, you'll need a
plugin for Windows). If you want
to be able to view certain files
from both operating systems (like
pictures, movies, etc.), this is a

wonderful idea to implement when
you install Ubuntu.

To make it more accessible in
Linux, you may want to change your
~/.home folder to point to that drive.
You can do this by clicking on System
> Administration > Users and
Groups. Find your profile, click
properties, click the advanced tab,
and change the location of your
home directory.

Now, you're probably used to
directories named "Windows" and
"Program Files." In Linux, these are
all over. Configuration files are
usually under /etc. More important
executables are under /bin, while the
less important are under /usr/bin. /lib
contains a bunch of libraries (similar
to .dll files in Windows, but they work
in a fundamentally different way),
and /media will give you a list of all
the drives you can access. There's
more, but that should give you a
basic idea of how it works.

Ubuntu will keep all these
organized very neatly if you stick
with repositories and Add/Remove. In
general though, you're going to want
to keep all movies, pictures, and
other media in your home
directory, and just make
additional directories to help
organize them.

Last off — to help keep things
good and neat you're going to
want shortcuts. For a program,
it's called a launcher and you just
have to know the exact name of
the program to make one
(example, the Terminal program
is actually called gnome-terminal
in some distributions).

To make a link to a directory,
run the terminal (Applications >
Accessories > Terminal) and type:

```bash
ln -s filename linkname
```

This means: make a symbolic
link (ln -s) of this file in this
location. An example of this
would be:

```bash
ln -s /home/user
/home/user/Desktop
```

That would make a shortcut to
your home directory on your
desktop.

Try Ubuntu, I promise that you'll
never want to go back!
This month we will discuss linking. You can have two types of links, one is where you link internally within your own document or externally where you link to something like a web page. I've made my page look nice and tidy for this one just to show you a few nice tricks.

Here is how my page now looks:

What I'll do first is show you how to create a basic link to a web page. First we need to create a 'hot spot' around the piece of text that will become the link. As you move over the PDF icon in the menu bar you will see a down arrow appear beside it, click that down arrow to get two choices:

We want the 'Link' option which looks like two footsteps. So click that and then draw a box around the text (or image) you want to be the link.

Now I have a PDF 'Link' box around my text, incidentally you can put this box around anything as it will always be on top so you could surround an image and some text too if you wish. Double click inside that box to get its properties

This is the Annotation Properties window. At the moment it says the Type is 'Link', click that down arrow and make it 'External Web-Link' this now gives a place to type in a web address so type one in and click OK

Nothing seems to have changed but you will see later that it will create a link. But how will people know it's a link? I can tell...
you now that in the final PDF the reader won't know the link from ordinary text so won't know there is a link there, what I usually do is to make the text blue and underlined just to pretend it's a web link.

Double click on the text box, select the piece of text that is going to be the link, give it a color and make it underlined.

That looks more like a link you would expect to see.

Let's add a few pages to the document just to show how an internal link works. In the main menu click Page > Insert and choose to insert four new pages.

So my document now has a total of five pages. I'm just going to put some large numbers on each page so that we can distinguish them from one another.

So let's return to page one and put in a link that will make the reader jump to page 5.

Again, click the PDF button in the menu and choose 'Link', draw the box around some text and again double click the PDF box.

This time keep the Type as 'Link' and make the page number show as five. You'll see the page preview on the right change to show your page five. The X and Y position is to let you give an exact location on the landing page, I'm going to make both of them zero which will make the top of the page touch the top of the PDF viewer's display area making the page display fully.

So let's give that a quick test by exporting the document to a PDF file.

In the main menu click File > Export > Save As PDF

You'll see the Pre-Flight Verifier window, just click 'Ignore Errors' for now, we'll go into this in more detail soon.

That is your 'Save As PDF' now which has all the options you need to fine tune your PDF file but for now choose a save location at the top of the window then click Save.

This is my exported PDF file in KPFD (I use KDE) with the active external web link, and if I click the second link:

It jumps me to page five as expected.

We are almost finished with learning the basics of Scribus, next month we will delve in to the 'Pre-Flight Verifier' and the 'Save As PDF' tabs and options.
WUBI INSTALLER 7.10

Written by Philipp Höhn

Are you reading this magazine because you're interested in Ubuntu and Linux in general? Are you running some form of Windows and want to try something new? Does thinking about installing something as huge as a new operating system make your knees quiver and your brow bead with sweat? What I say to you is: Never fear -- Wubi is here!

I can confirm that Wubi does this with little to no fuss. Wubi itself is comprised of a single executable file so you can run it from anywhere, hard drive, flash drive, external HDD, floppy (Well, let's not exaggerate)... you get the picture? It has a clean, minimalistic interface containing only three options. Once those options are filled and finalized, click install and you're good to go. That's how easy it is!

Let me explain: what Wubi does in essence is install Ubuntu on your computer as a single "file," no need to partition, format, resize or anything. There will be only one single file and one single file only. This will will hold all of your Ubuntu installation as well as any programs you install later. It is not installed into an emulated environment. It is a normal setup in every sense of the word. It uses your native hardware and performance is identical to a dedicated installation. The Wubi FAQ states that hard-disk access is slightly slower than a dedicated installation. Throughout my time with a Wubi install I have not had any problems with hard-disk access speed. Ubuntu seems to me to be as quick and smooth as a dedicated install.

After installation you are prompted to reboot your computer, and upon rebooting you will be shown your new boot menu which will list your Windows OS as well as your Ubuntu installation. Choosing the Ubuntu-Linux installation will show you the pleasant Ubuntu
splash screen. All of this is easy as cutting a stick of butter - yes, that easy! I remember an application some years ago that did the same basic thing, install Linux inside the Windows environment. It was nowhere near as plain and simple as this installation was.

There are a few caveats to installing Wubi that I think are worth noting. I hope they get fixed at some point. First, only the 32-bit version of Ubuntu is supported, so if your computer has a 64-bit processor you'll have to stick to the 32-bit version of the OS. The developers do plan on adding this in the future but for now it is 32-bit only. Second, Hibernate/Suspend is not available when running under a Wubi install. If you don't like your present Ubuntu setup and want a dedicated install, then you'll have the ability to utilize hibernate/suspend. Third, you should try to avoid hard reboots. The Wubi install of Ubuntu is susceptible to damage during hard reboots. Similar to hibernation/suspend, on a dedicated install but it really should not be a problem.

Other than these few “issues” I have had a stable Ubuntu install for quite a while now. I have been very pleased by this little piece of software. I recommend Wubi to anyone I know that is interested in playing with or running Ubuntu/Kubuntu/Xubuntu on their machines. It makes an easy job of installation and, if the user chooses, uninstallation.

I hope this review/article has helped you and presented an idea of what Wubi is. Remember that if you are interested, Wubi is out there for you to download. Go check it out!

**Overall:** 🌟🌟🌟🌟🌟🌟

**NOTE:**

I did a little more looking and found a link for the latest 7.10 development Alpha’s of Wubi.


I did my review from the Rev377 version but (as I write this) the developers are now up to Rev383. So if you want to install 7.10 on your system you'll need to use one of those Alpha releases.
This month's poll was taken from a poll which was running on Ubuntu Forums. If you would like to create a poll for Full Circle Magazine then go to www.UbuntuForums.org, go to the 3rd Party forum then click Full Circle Magazine. Create your poll in that sub-forum only.

**View Poll Results: What is your favorite email client/communication suite?**

<table>
<thead>
<tr>
<th>Email Client/Communication Suite</th>
<th>Votes</th>
<th>Percentage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Evolution</td>
<td>110</td>
<td>25.29%</td>
</tr>
<tr>
<td>Thunderbird</td>
<td>211</td>
<td>48.51%</td>
</tr>
<tr>
<td>Mozilla</td>
<td>2</td>
<td>0.46%</td>
</tr>
<tr>
<td>Pine</td>
<td>9</td>
<td>2.07%</td>
</tr>
<tr>
<td>Balsa</td>
<td>1</td>
<td>0.23%</td>
</tr>
<tr>
<td>Mutt</td>
<td>14</td>
<td>3.22%</td>
</tr>
<tr>
<td>Kmail (for those 10heads)</td>
<td>31</td>
<td>7.13%</td>
</tr>
<tr>
<td>Other</td>
<td>57</td>
<td>13.10%</td>
</tr>
</tbody>
</table>

I like the simplicity of thunderbird too, but what really got me is the spam filter, it is the best in the world. Why? Because you tell it what is spam and what is not spam.

**amoser**

I definitely prefer Thunderbird. I used Kmail for a long time prior to that, until I discovered the junk mail controls in Thunderbird. That and it's simple to setup/use.

**cabu**

Evolution because: I can backup my mail to a .pst type file (unlike Thunderbird), it looks pretty (much better than the old Evolution under Red Hat 9), I can download mail & still keep it on my email server (POP), I can use POP and IMAP, I also use Outlook2000, so it has the same look & feel of Outlook, I use web-based Yahoo Mail as my spam catcher and because I use fastmail as my "real" email account.

**wallijohn**

I use Thunderbird as my main e-mail client, as I am using IMAP and then have more or less the same client for my three plattforms MacOS X, Windows and Linux.

**frankps**

I use Gmail and Evolution. Gmail seems to do a great job filtering spam so my email is pretty clean by the time it gets to Evolution. The main reason I use Evolution is because it includes a calendar, to do list, etc. that I can sync with my Palm Pilot.

**caric**

Thunderbird - It does exactly what i want it to do. I also like the integrated e-mail program that comes with Opera.

**Monchy**

I use Evolution because I'm too lazy to install something else and that's what came with my installation.

**bmbeeman**

Web Mail. I stopped using email clients a long time ago.

**Maggot**

I have mutt setup to fetch/send using my gmail...works for me.

**plb**

I've just discovered sylpheed claws and for now I'm gonna stick with it. It's fast and powerful.

**karellen**

I use Kmail for both personal and business email. The integration with Kontact, the PIM, was the deciding factor. I had used Outlook 2xxx for several years, then Thunderbird for two or three years, and now Kmail/Kontact. Really satisfied with it, too, and it offers more features to me than Thunderbird (a good client as well, if all you do is mail).
In 2004, the **Howard County Library** made news when they switched 300 of their public computers from Windows to an in-house Linux solution. Recently, they upgraded the computers to a version of **Ubuntu** distributed by Groovix. We talk to **Amy de Groff**, Head of IT for the library.

**Before switching to Linux, what software was the library using?**

They were running Windows NT. A former IT person had shut down a great deal of the functions, access, etc.

**How did the library first get interested in Linux? What aspects of Linux were attractive?**

We got interested in Linux because two of our IT guys (former Unix administrators) were big fans. What we liked about it was the ease of management from a remote location (we have 6 branches and, at that point, two IT guys managing the machines) and the ability to strip off functions, applications, and services that we did not want.

The financial aspect was also attractive, but it was actually NOT the first thing we fell in love with. I see it as an added bonus and a wonderful service to our community that I can offer a streamlined desktop AND save money!

**How was the first switch?**

The first switch was from the NT environment I described above to LuMix, [a Linux distribution] designed and managed by Mike Ricksecker and Luis Salazar.

LuMix basically just had a browser, Mozilla, stripped to bare essentials. We put it on all but three machines at each branch, leaving NT on those with MS Office 97.

LuMix ran like a top for nearly 2 years, but customers wanted more. They wanted word processing, they wanted access to USB flash drives (we'd shut that down in LuMix and it was not available on our NT version) so we started thinking "what next?"

One option was, of course, to rebuild and upgrade LuMix. Mike began work on LuMix 3.0 (as we were tentatively calling it).
At the same time, we researched the vendor world, and we found two interesting options: a Canadian firm called Userful, and a technology called Groovix, built by Open Sense Solutions.

We chose Groovix. Hard to quantify why - it just felt more open and we liked very much the support staff.

**How long did you evaluate the Groovix / Ubuntu solution before deciding to move forward?**

We evaluated Ubuntu for two months. To be honest, I was sold ten minutes in, but I knew I had to give it more time and use. I am truly amazed at the usability of Ubuntu - I think it is down-right elegant.

**What expenses were associated with the switch to Groovix / Ubuntu?**

It cost us around $20,000 to upgrade the memory on the 300 PACs (we went from 128 to 512), and we spent $25 on the software (yes, 25 dollars).

We pay for support from Open Sense Solutions - a flat, yearly rate that is about 1/10th of what we pay for other enterprise-wide software.

Had we remained a Windows shop and chosen XP instead, we probably would have replaced the hardware entirely, anticipating the move to Vista. At around $800 for each of 300 machines, that would have cost $240,000.

**What has the library done with the money saved so far by this switch?**

Some of the money we saved so far has gone to hardware - we bought lovely 19" flat screens for every single machine.

**Is it safe to say that the Library will continue to save money in the future, as a result of switching to Ubuntu?**

Very safe to say. We'll continue to use the funds for service - computer training, books, movies, programs, and hardware upgrades.

**What kind of requests for help has your staff received from patrons?**

Our requests for help / help desk tickets have dropped by 40% since the Windows NT days. Most customers sit at the machine and work away, requiring no help. Customers who are less comfortable on a computer have questions, but they are not Linux-based. Instead "how do I bold text?" or "how do I add a page break?" The kind we'd get with any application.

Most help desk tickets now are hardware problems, a hard drive dying or a machine being unplugged (one of the most common ones, actually).

**How has the staff responded to the switch?**

All in all, they are fine.
We have a few staff who are reluctant to move to OpenOffice. They maintain that because it is free, it is not as good. I really don't agree with that opinion. We are moving all staff to Ubuntu desktops this fall and winter so, soon, they will be using OpenOffice. I do hope those who are uncomfortable come around. I work hard to do one-on-one training and to be a cheerleader for them.

**Have you had any problems with the new Ubuntu computers?**

The only problem is that a few websites, for example some college grade sites, require Internet Explorer and won't work here. And we don't apologize for that, we encourage our customers to express their frustration.

We had one machine that kept "turning off for no reason" - of course many assumed it was the "third rate" open source software. Turned out the user was a leg swinger - she was bumping the power switch!

**Is there any software that the library would like to use that is not available in Linux?**

The sole piece of software we can't use here is the CLIENT for our integrated library system. It is a shame, because this vendor's plan, presented to us three years ago, was to be entirely web-based by now.

That vendor changed course, and while I could have chosen to change course with them and abandon our vision of Linux system wide, I will not. I can't let any vendor dictate how I spend tax payer money.

**What barriers do you see preventing other libraries from switching to a similar solution?**

I think the biggest barrier facing libraries in doing what we have done is fear of the unknown. We ran into this, of course. When people started USING the software they would often come into my office sheepishly and say, "um, this is not a big deal," and I would smile and say, yup!

**Can library patrons play a role in getting their libraries to evaluate open source software?**

Library patrons can and should request an accounting of what software costs, especially with Vista on the horizon.

Patrons should ask, 'why move to Vista? What does it give me as a customer?'

One Vista user told me the 3D functionality was 'cool'. I said, 'what does that do to get my customers information about my collection?' There was no answer.

**Thank you so much for your time, Amy!**

It was my pleasure! I am proud of what we are doing and I would love to help other groups use Ubuntu. I would also like to hear about other projects or applications that your readers think would be nice additions to our deployment!

Amy can be contacted at amydegroff@hclibrary.org
I was a bit apprehensive before installing Ubuntu as I had heard a lot of worrisome stories about Linux in general and how it requires special computer knowledge to install it. But when I put in Ubuntu Live CD, my fears were dispelled. To my amazement I found that it can run from a Live CD without installation, allowing me to preview all the features of the operating system. Then I worked up the courage to partition my hard disk and dual boot with Windows (I still wanted to cling onto Windows). Although the installation was easy, the games were fun to play and all my hardware was detected properly, I had a setback when I found out that I could neither listen to my huge collection of MP3s nor watch any movies in spite of having a lot of media players.

There were two problems to be overcome. First, the problem of accessing my many years of data in my Windows partitions and second, downloading the necessary packages for making proprietary formats work. I googled my problems and found a whole new resource - Ubuntuforums.org. This forum had many contributors and lots and lots of people ready to help out. I still remember that my first question on the forum was answered within 10 minutes! Also, there is a lot of documentation regarding the free software and tips to do work in Ubuntu. By following posts and articles, I soon had my own customized system. I learned more about operating systems in that short time than I had been able to learn in year of Windows use!

I seldom used the command line in Windows and my experience has shown that Windows users have a fear of the terminal. In a Windows environment, the command line is used mainly when you have to fix things like a virus, for example, but in Ubuntu, the command line is a way of life! I have come to love the command line.

Now, you might be wondering why I decided that Ubuntu is a better operating system for me when I had to spend so much time struggling to install software. Well, in the past year with Ubuntu I have never once been struck by a virus. I did not
even have to buy a Norton subscription for that. I have neither needed to defragment my hard disk (thanks to the ext3 filesystem), nor encountered the "Blue Screen of Death." There were times when my computer would hang, though I've always been able to use a "force quit" and have never had to send an error report! All of this and I haven't even mentioned that I got the office suite, a large number of games, an excellent media player (now that I have downloaded the codecs and can even run .FLV and .RMVB files in Mplayer, something that Windows Media Player could never do) and a great instant messenger through which I can log into any instant messaging account.

Linux is also a great platform to learn C programming. You do not have to install gigs of Visual Studio, but can have a gcc compiler which can do everything you want and is only 5-6 MBs at the max. What's more, Anjuta has almost all the functionality of any other popular IDE. I used it to do my Introduction to Programming assignments at school while other classmates were busy arranging software to run on Windows.

So, although I get free access to Windows and some other Microsoft proprietary software from my university's software distribution program, I still find myself using Ubuntu more and more as I find it to be a more stable, modest and better overall operating system. It may not be as flashy in its claims as Windows and you do require a certain working knowledge of computers, but once you start using it, you will love it.

---

**Full Circle Podcast**

Hi, I'm Matthew Rossi and I will be your host for the **Full Circle Podcast**. I am also the host of The Penguin Central Podcast. Here I will answer a few questions about the new podcast. If you have any questions, I can be contacted at podcast@fullcirclemagazine.org.

**What will the podcast be about?**

The Full Circle Podcast will, like the magazine, be about all flavors of Ubuntu. The show is designed to complement the magazine yet come up with our own content.

**Will the podcast cover everything in the magazine?**

No. What is covered in the podcast is at my discretion.

**Who will be on the show?**

I will be the host, and we will have a panel, and guests.

**How often will the show be released?**

Full Circle Podcast will come out the first and third week of each month. This is subject to change, as are the schedules of the hosts.

**What day will the show be released?**

That hasn't been decided yet, but subscribe to the podcast RSS feed at: http://url.fullcirclemagazine.org/c796aa and you will find out as soon we decide.

We can't wait to bring you Episode 1. But for now, you can check out The Penguin Central Podcast at http://penguincentral.co.nr/

**Regards,**

Matthew Rossi
S
o you've installed the latest version of Ubuntu, you've
got your wicked awesome
Compiz Fusion effects set up —
now what?

I asked the same question
about a year ago when I started
with Kubuntu 6.06. So here are a
few things I came up with to keep
you from getting bored.

1. Explore the file system

Trust me, you can learn a lot
this way. Here's what you do:
open your file manager and press
the “up one directory” button
twice. This should take you to the
top level of your installation. You'll
see a bunch of directories like
/usr, /proc, and /home. Look
through them and find out what
they're for. I would highly
recommend Linux Reality podcast
episode 11 for this:
http://url.fullcirclemagazine.org/111c30

2. Try an obscure Window
manager

By default, Ubuntu comes with
GNOME, KDE, or XFCE. Why not try
something different? IceWM or
 Fluxbox are two alternatives. They're
both fast, free and in the Ubuntu
repositories. Just go into Synaptic (or
Adept, if you're a Kubuntu user like
me) and search for “window
managers”.

3. Figure out that command line

Try using the command line for a
day. Use it for everything! Try Elinks
or w3m. Try some CLI games. Heck,
even try managing your music
collection! It's faster than a window
manager and infinitely more flexible.
See:
http://url.fullcirclemagazine.org/745c00

4. Code, code, code

Try learning a programming
language like Ruby or Python. I have
been learning Ruby for the past
few months and I'm really
enjoying it. For some tutorials on
programming, see
http://pine.fm/LearnToProgram/
or www.python.org. Or if you're a
book person like me, take a look at:
http://url.fullcirclemagazine.org/9d47a0
or:
http://url.fullcirclemagazine.org/b2a379

5. Contribute

The nice thing about the
Ubuntu community is that
they're always open to your
ideas. Send in a feature request
to your favorite project. If you
can code, try making some of
those features possible. You
could even try writing for Full
Circle Magazine!

Now have fun, and remember
that you have no reason to be
bored!
I'm Matthew Rossi, host of the Full Circle Podcast, and here are my picks for the big stories in the Ubuntu world. This month, I will be rounding up the events at the Ubuntu Developer Summit. The full articles can be found at http://fridge.ubuntu.com/taxonomy/term/13. Some of the highlights for me in The Fridge wrap up were:

* Support for the ClassmatePC platform. That's an interesting one.

* Creating an Ubuntu Mobile community. Well, having Ubuntu on the go is a great thing. And who's going to crawl around on the forums and help those who are in need? Great idea.

* Easy File Sharing! This is desperately needed. As far as I know it isn't the easiest thing to set up sharing between two computers where one of the computers is an Ubuntu computer.

* The Screencasts on CD blueprint. Now this is something that I know of, and I will always endorse the idea. The idea is explained well here https://wiki.ubuntu.com/ScreencastsInUbuntuSpec. It's an excellent idea.

* A Windows installer. It's an interesting concept, but I take the traditionalist view on it, saying why would you want to install Linux inside Windows if you have had enough of it? Good luck to them anyway.

* The 2.6.24 Kernel. The Kernel is the make or break of any Linux distribution, and I wonder if Linus agrees with me... It will be interesting to see how big the kernel will get. The release candidate weighed in at 11 megabytes. Hopefully it can shed some weight in time.

* Building a community around "enterprise" Ubuntu - That is helpful. The need of an Enterprise Ubuntu community shows how popular Ubuntu is becoming in the business world. We'll just have to wait and see.

And that is my wrap up of UDS Boston, albeit standing from the sidelines. There is another round up of the day by day events which you can find in the Ubuntu Weekly News #64 https://wiki.ubuntu.com/UbuntuWeeklyNewsletter/Issue64
There are loads of ways in which you can contribute to Ubuntu (see FCM#6 letter), programming is only one of those ways.

For instance, if your own language is something other than English, then you can help translate software and documentation to your own language.

Another way to contribute to Ubuntu is by simply going into the forums or on IRC and help people solve any problem they are having.

If you know how to do something in Ubuntu, then you could write a Wiki article (https://wiki.ubuntu.com/) or if you have a great idea on how Ubuntu can be improved, you could submit it to the idea pool at https://wiki.ubuntu.com/IdeaPool

I made this pumpkin by printing out the Ubuntu logo and taping it to the pumpkin. I used one of those pokers that come in pumpkin carving kits to poke holes in the pumpkin along the lines where I had to cut, then I just cut along the lines. I decided to make the Ubuntu pumpkin, because I wanted to do something different from the standard "scary" pumpkin. Not a lot of people saw the pumpkin, but someone said that the only person that would think it was scary would be Bill Gates. LinuxLoop — www.linuxloop.com

Those are just a few of the ways in which you can help make Ubuntu a better experience for everyone. You can find more ways at http://www.ubuntu.com/community/participate

Gnome, KDE and XFCE are desktop environments, not window managers, although they have built-in window managers (in order: Metacity, Kwin, xfwm), we can't make confusion with these two terms. These ones are okay: Compiz and Beryl are really window managers as they only replace metacity, kwin or xfwm. By the way, Compiz fusion is not the window manager itself, it's just the replacement for Compiz-extras, merging old compiz

Balaam

I think there was a mistake in the poll it issue #6. Window manager and desktop environment are two different things.
plugins with Beryl ones.

A window manager can be used in all other desktop environments (at least in theory), but the best thing is to keep the desktop environment default one. With the introduction of compositing window managers (the ones that make all those cool effects, just to remember the window manager is the one that do those effects to the windows not the desktop environment) it became common to replace the default one with another (cool) one like people do when putting Compiz (Fusion) in Gnome. They are actually replacing Metacity with Compiz (yet putting extra plugins if they are installing compiz fusion also)

Onilton Maciel

Ed: You are of course right but look how long it took to explain what you mean by Window Manager and Desktop Environment. We purposely lumped everything together to make the question short and less complicated to new users.

I think I've met the same problem as Anthony Stellato (Letters page of FCM#6), maybe mine is even worse!

I have installed totem-xine and mplayer with w32codecs in my Gutsy Gibbon, but I can not open my HD videos (or movies) with them. Each time I try to use mplayer or totem-xine to open my 720p or 1080p movies, none of them worked, it quit automatically not long after I double clicked the HD movie file.

So, please help me and other friends with the same problem!

By the way, I am a loyal reader of Full Circle Magazine, I've read all the issues, they are great! I like the Top 5 very much, which is very useful. While on the subject, could you list some downloading tools for us in the next issue please? Thank you.

ming

Ed: Glad you like the magazine ming! I'll pass your request for download managers to Andrew.

Is it possible to have an article explaining a how to create a media center with the packages provided on the repository?

damvcool

Ed: As far as I'm aware Robert Clipsham, Flavor of the Month writer and FCM Communications Manager extraordinarre is thinking of doing a Mythbuntu install for #8. Stay tuned! Hey, I made a funny!

I think Full Circle Magazine is a great resource. I have a suggestion though: I think there should be some small blurb somewhere near the front, letting people who know nothing, nothing at all, about what Ubuntu is and where they can learn more.

Matthewcraig

Ed: Good point. We now have a 'What is Ubuntu?' info box on the Editorial page.
Q Since I upgraded to the Gutsy Gibbon I have only been able to access websites by using their IP addresses, and anything else Internet related won't work - why is this?

A There are several simple ways to solve this. The easiest one is just to disable ipv6, which can be done by doing 'gksudo gedit /etc/modprobe.d/blacklist' in a terminal (kdesu kate /etc/modprobe.d/blacklist in KDE), then adding 'blacklist ipv6' to the end of the file. Restart your PC and ipv6 will be disabled. Look at the link below to find other ways to solve this.

https://help.ubuntu.com/community/WebBrowsingSlowIPv6IPv4

Q Can Ubuntu use more than 4GB of RAM?

A If you want to use more than 4GB of RAM in Ubuntu you need to download the 64 Bit version. When on the download page you need to choose the '64bit AMD and Intel computers' option.

http://ubuntuforums.org/showthread.php?t=605649

Q I'm running the server edition of Ubuntu, but need a GUI. How can I install one?

A Use 'sudo aptitude install' followed by ubuntu-desktop, kubuntu-desktop or xubuntu-desktop, depending on which user interface you want. You will also need to install gdm (Gnome) or kdm (KDE).

http://ubuntuforums.org/showthread.php?t=605836

Q I would like to learn some basic commands in Linux. Are there any good sites for this?

A The Ubuntu help site has a good guide at https://help.ubuntu.com/community/UsingTheTerminal, which will show all the basic commands for using a terminal in Ubuntu. There is also a more general guide at http://linuxcommand.org/ which applies to all distributions.

http://ubuntuforums.org/showthread.php?t=605801
I am brand new to Linux. My first and only attempt so far has been with Ubuntu. I am very satisfied with my choice. I think that desktop modifications are easy to preform by a new Linux user, too.

The flavor I use is Ubuntu Studio. (You can get it from the repositories. For instructions visit www.ubuntustudio.org) The icon package, Dropline Neu, is available from art.gnome.org You can download the mouse theme from www.gnome-look.org Search for Fedora Core 6 Cursors.

My desktop customization uses only what is available by default in Kubuntu Gutsy Gibbon (7.10). Here is how you may do it for yourself:

* Enable transparency for the panel.
* Set the tint amount to around 50%. The tint color I have used is the default.
* The wallpaper is the "Alta Badia" one which comes with Kubuntu.
* The OSD on the top is displayed just as Amarok starts playing a song.
* Katapult is used to open the Digikam.

Other specs:

* KDE 3.5.8.
* Acer AL1702W widescreen monitor at a resolution of 1440x900.
* nVIDIA GeForce 4000 MX.
* 256 MB RAM.
* Intel Celeron running at 2.0 GHz.
**Audacity**


Audacity is a simple yet powerful digital audio editor. Started as a basic editor by Dominic Mazzoni during graduate school, Audacity has grown to include features such as up to 16 channels of recording, 16, 24, and 32 bit samples, rates up to 96 KHz, easy copying and pasting, unlimited undos, mixing, plug-ins, effects, support for plugins written in LADSPA, VST, and Nyquist, and boasts WAV, AIFF, MP3 (using LAME), FLAC, and OGG support. It's no wonder it won the Best Project for Multimedia prize in the 2007 SourceForge.net Community Choice Awards.

To install Audacity, just grab the audacity package in the Universe repository.

---

**LMMS**

Homepage: [http://lmms.sourceforge.net/](http://lmms.sourceforge.net/)

LMMS (Linux MultiMedia Studio) is another great all-purpose sound editor. Similar to the commercial Cubase or FL Studio, LMMS combines a powerful synthesizer with a great tracker/sequencer program to create an amazing audio editor. With it, you can also capture input from MIDI keyboards, write music with a great song editor, add loops or beats, or use plugins for LADSPA and Cubase (with WINE). All wrapped into a powerful yet easy to use Qt-based GUI.

To install LMMS, all you need to do is get the lmms package in the Universe repository.
If video editing is more your style, try out LiVES. It's a powerful tool that mixes a real-time editor and a non-linear editor into one package. Throw in some nice add-ons, scripts, filters, and support for virtually any format (it uses MPlayer), and you've just scratched the surface of what it is capable of.

Although LiVES is one of the greatest Ubuntu editors, it didn't make it into the Ubuntu repositories. Luckily, GetDeb.net has a package at http://www.getdeb.net/app.php?name=LiVES.

Avidemux was created for those who don't need the kitchen sink in their video editor. Instead, Avidemux offers a simple interface with features such as cutting/appending clips, filters, support for encoding and decoding all the popular formats (including AVI, ASF, QuickTime, MPEG, and WMV), muxing (and demuxing) support, OCR subtitles, and scripting using ECMAScript. And if you're a Kubuntu user, you'll be glad to learn that the new version includes a Qt version along with the default GTK.

avidemux is included in Ubuntu's Multiverse repository.

If you're a Kubuntu user, you'll want to try Kdenlive. This non-linear video editor includes full FFMPEG support (so it will import and export virtually any format you throw at it, including AVI, MPEG, OGG, and VOB), 4:3 and 16:9 aspect ratios, PAL and NTSC format support, DVD burning, multi-track editing, basic audio and video effects and transitions (with real-time previews), slideshows, and more. All in a rich KDE interface supporting ten different languages.

To install Kdenlive, just install the kdenlive package in the universe repository.
**How to Contribute**

We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:

http://wiki.ubuntu.com/UbuntuMagazine

Please email your articles to: articles@fullcirklemagazine.org

If you would like to submit news, email it to:

news@fullcirklemagazine.org

Send your comments or Linux experiences to:

letters@fullcirklemagazine.org

Hardware/software reviews should be sent to:

reviews@fullcirklemagazine.org

Questions for future interviews should go to:

questions@fullcirklemagazine.org

Lists and desktop/PC photos should be emailed to:

misc@fullcirklemagazine.org

If you have questions, you can visit our forum:

www.fullcirklemagazine.org

---

**Have Your Say**

If you want to have your say in how Full Circle develops, please attend our monthly IRC meeting.

You can find our next Agenda at:

http://url.fullcirklemagazine.org/f2ba08

We want the input of you, the reader, to help us make decisions that affect the magazine.

Next general, all welcome, meeting: **Sat. 08th December**

Meetings take place in the IRC channel #fullcirklemagazine, which is on the irc.freenode.net server. Or you can use our webIRC page which is at http://irc.fullcirklemagazine.org and it will allow you to interact with our IRC channel from within your web browser.

---

**Full Circle Team**

**Editor** - Ronnie Tucker  
ronnie@fullcirklemagazine.org

**Webmaster** - Rob Kerfia  
admin@fullcirklemagazine.org

**Comms Mgr** - Robert Clipsham  
mrmunday@fullcirklemagazine.org

**Podcast** - Matthew Rossi  
podcast@fullcirklemagazine.org

**Contributors**

Samuel Barratt  
Robert Clipsham  
Daniel Cohen  
Philipp Höhn  
Andrew Min  
Vid Ayer

**Proof Readers**

Nicola Cappellini  
Jonny Dover

Ryan Hartlage  
Matthew Holder

David Maino  
Richard Mills

Andrew Min  
Alex Russell

James Savage  
James Williams

And our thanks go out to **Canonical**, the **Ubuntu Marketing Team** and the many translation teams around the world.